
 

Jurnal Ilmu-ilmu Hayati 

             P-ISSN 0126-1754 
             E-ISSN 2337-8751 
           Terakreditasi Peringkat 2 
             

Volume 19 Nomor 3A, Desember 2020 

 
Pusat Penelitian Biologi - LIPI 

 Vol.  No. 3A      Hlm.     ISSN  



BERITA BIOLOGI 
 

Vol. 19 No. 3A Desember 2020 
Terakreditasi Berdasarkan Keputusan Direktur Jendral Penguatan Riset dan  

Pengembangan, Kemenristekdikti RI 
No. 21/E/KPT/2018 

 
 

Tim Redaksi (Editorial Team) 
Andria Agusta (Pemimpin Redaksi, Editor in Chief) 
(Kimia Bahan Alam, Pusat Penelitian Kimia - LIPI)  

 
Kusumadewi Sri Yulita (Redaksi Pelaksana, Managing Editor) 

(Sistematika Molekuler Tumbuhan, Pusat Penelitian Biologi - LIPI)  
 

Gono Semiadi 
(Mammalogi, Pusat Penelitian Biologi - LIPI)  

 
Atit Kanti 

(Mikrobiologi, Pusat Penelitian Biologi - LIPI)  
 

Siti Sundari 
(Ekologi Lingkungan, Pusat Penelitian Biologi - LIPI)  

 
Arif Nurkanto 

(Mikrobiologi, Pusat Penelitian Biologi - LIPI)  
 

Kartika Dewi 
(Taksonomi Nematoda, Pusat Penelitian Biologi - LIPI)  

 
Dwi Setyo Rini  

(Biologi Molekuler Tumbuhan, Pusat Penelitian Biologi - LIPI)  
 
 
 

Desain dan Layout (Design and Layout) 
Liana Astuti 

 
 
 
 

Kesekretariatan (Secretary) 
Nira Ariasari, Budiarjo 

 
 
 
 

Alamat (Address) 
Pusat Penelitian Biologi-LIPI 

Kompleks Cibinong Science Center (CSC-LIPI) 
Jalan Raya Jakarta-Bogor KM 46, 
Cibinong 16911, Bogor-Indonesia 
Telepon (021) 8765066 - 8765067 

Faksimili (021) 8765059 
Email: berita.biologi@mail.lipi.go.id 

jurnalberitabiologi@yahoo.co.id 
jurnalberitabiologi@gmail.com 

 

 
Keterangan foto cover depan:  Pertumbuhan Oedogonium sp. pada perlakuan cahaya yang berbeda. Oedogonium sp. Pada kultur 

      Outdoor tampak lebih padat daripada kultur indoor, sesuai dengan halaman 309 

(Notes of cover picture):           (Growth of Oedogonium sp. at different light treatments. Oedogonium sp in outdoor culture appeared 

      denser than in indoor culture, as in page 309)  

 



P-ISSN 0126-1754 
E-ISSN 2337-8751 

            Terakreditasi Peringkat 2 
                                               21/E/KPT/2018 

Volume 19 Nomor 3A, Desember 2020 

Pusat Penelitian Biologi - LIPI 

Jurnal Ilmu-ilmu Hayati 



 
Ucapan terima kasih kepada  
Mitra Bebestari nomor ini 
19(3A) – Desember 2020 

 

 
Dra. Djamhuriyah S. Said M.Si. 

(Ekologi dan Evolusi (Konservasi dan Pengelolaan Lingkungan) 
Biologi Konservasi, Pusat Penelitian Limnologi- LIPI)  

 
Gratiana E. Wijayanti, M.Rep.,Sc., Ph.D 

(Perkembangan dan Reproduksi Hewan, Fakultas Biologi Universitas Jenderal Soedirman) 
 

Prof. Dr. Suradi Wijaya Saputra, MS. 
(Biologi Perikanan/Dinamika Populasi/Manajemen SDY Perikanan, FPIK  

Universitas Diponegoro) 
 

Dr. Adi Santoso 
(Bioteknologi, Pusat Penelitian Bioteknologi - LIPI) 

 
Kartika Dyah Palupi S. Farm.  

(Fitokimia, Pusat Penelitian Kimia-LIPI)  
 

Dr. Sc. Agr. Agung Karuniawan, Ir., Msc. Agr. 
(Pemuliaan Tanaman, Fakultas Pertanian, Universitas Padjadjaran) 

 
Dr. Henti Hendalastuti Rachmat 

(Genetika, Silvikultur, Pusat Penelitian dan Pengembangan Hutan) 
 

Hani Susanti M.Si. 
(Bioteknologi, Pusat Penelitian Bioteknologi - LIPI) 

 
Dr. Diah Radini Noerdjito   

(Mikobiologi Laut, Pusat Penelitian  Osenaografi - LIPI) 
 

Ade Lia Putri, M.Si.  
(Mikrobiologi/Aktinomisetes, Pusat Penelitian Biologi- LIPI) 

 
Dr. Dra. Shanti Ratnakomala, M.Si. 

(Mikrobiologi, Pusat Penelitian Biologi - LIPI) 
 

Zuliyati Rohmah, S.Si., M.Si., Ph.D. 
(Struktur perkembangan hewan invertebrata dan vertebrata, Fakultas Biologi,  

Universitas Gadjah Mada) 
 

Dr. Nani Maryani 
(Mikologi/ Plant Pathology, Pendidikan Biologi, Universitas Sultan Ageng Tirtayasa) 

 
Muhammad Ilyas, M.Si. 

(Mikologi, Pusat Penelitian Biologi- LIPI) 
 

 Dr. Roni Ridwan 
(Bioteknologi Hewan-Nutrisi Ternak, Pusat Penelitian Bioteknologi- LIPI) 

 
Deden Girmansyah, M.Si 

(Taksonomi Tumbuhan (Begoniaceae), Pusat Penelitian Biologi - LIPI) 

https://intra.lipi.go.id/home/profile_sivitas/kart009


 



  335

                                                          DOI: 10.14203/beritabiologi.v19i3.3945 
P-ISSN 0126-1754                                                                                                                
E-ISSN 2337-8751 

*Kontributor Utama 
*Diterima: 13 Agustus 2020 - Diperbaiki: 22 September 2020 - Disetujui: 6 November 2020 

PENDAHULUAN 
Penyakit layu Fusarium atau dikenal dengan 

nama Panama Disease pertama kali ditemukan di 

Panama pada abad ke-19 (Ploetz, 2008). Penyakit ini 

termasuk tipe soil-borne yang disebabkan oleh  

patogen Fusarium oxysporum f. sp. cubense 

(O’Donnell et al., 1998; Maryani et al., 2019) 

Menurut FAO, penyakit Fusarium merupakan  

penyakit yang paling merugikan di pisang. Dampak 

dari penyakit ini yaitu dapat menyebabkan 

penurunan produksi pisang yang signifikan hingga 

100% (FAO, 2019). Penyakit ini telah menyebabkan 

kerusakan ribuan hektar pisang cv. Gros Michel di 

Amerika Tengah pada awal abad 20-an. Hal tersebut 

membuat pisang cv. Gros Michel kemudian  

digantikan oleh pisang cv. Cavendish karena lebih 

tahan terhadap serangan penyakit Foc race 1 

(Maryani et al., 2019). Saat ini, solusi pencegahan 

yang paling efektif untuk penanganan penyakit layu 

Fusarium adalah menanam varietas pisang yang  

tahan terhadap penyakit layu Fusarium. Dale et al. 

(2017) telah berhasil mengembangkan pisang  

transgenik yang tahan terhadap penyakit Foc  

Tropical Race 4 (Foc TR4) dengan menyisipkan gen 

RGA2 ke dalam pisang cv. Cavendish. Dalam proses  

pengembangan pisang tahan penyakit, analisis 

serangan Fusarium sangat penting perannya dalam 

proses pengujian ketahanan (Bioassay). Beberapa 

metode telah digunakan untuk pengamatan penyakit 

layu Fusarium di pisang secara visual (Orjeda, 1998; 

Mak et al., 2004, Smith et al., 2008; dan Viljoen et 

al., 2016,). 

Ahmad Zaelani*, Wulan S. Kurniajati, Herlina, Diyah Martanti dan Fajarudin Ahmad  

Bidang Botani, Pusat Penelitian Biologi-LIPI. Jl. Raya Jakarta-Bogor Km. 46, Cibinong, Bogor 16911  
email: ahmadzaelani.zae@gmail.com/ahmad.zaelani@lipi.go.id  
 

ABSTRACT 
Fusarium wilt disease caused by Fusarium oxysporum f. sp. cubense is the most dangerous disease in banana. Recently, development of new 
banana varieties has been the most effective ways to prevent this disease. To develop the resistant banana, Fusarium severity analysis is the 
important part in the process of Fusarium disease assessment to quantify the disease severity. The objective of this study was to develop 
digital image analysis method for Fusarium severity analysis by using software ImageJ. Pisang Ambon and Pisang Cavendish were used as 
plant material due to its susceptibility of the disease. Fusarium severity analysis performed as follows (i) Photographing of Fusarium-
infected rhizom (ii) Digital image analysis by using ImageJ of the taken image. The analysis result was percentage area of Fusarium-infected 
rhizom, represented by necrosis and discoloration. The percentage of rhizome infected by Fusarium on Pisang Ambon#1 was 50.10%, while 
Pisang Ambon#2 was 22.23%. In addition, the percentage of Pisang Cavendish#1 and Pisang Cavendish#2 was 28.52% and 39.5%,  
respectively. Digital image analysis of the sample showed consistent result and more objective. Development of the digital image analysis is 
not only useful for Fusarium severity analysis in Banana, but also for other crops.  
 
Keywords: Banana, Digital Image Analysis, Fusar ium Wilt Disease, Im ageJ 

 
ABSTRAK 

Penyakit layu fusarium disebabkan oleh Fusarium oxysporum f. sp. cubense merupakan penyakit yang paling merugikan di Pisang. Saat ini, 
pengembangan varietas pisang baru yang tahan terhadap penyakit layu Fusarium masih menjadi cara yang paling efektif untuk mencegah 
serangan dari penyakit ini. Untuk pengembangan varietas pisang tahan baru, analisis serangan Fusarium sangat penting perannya dalam 
proses pengujian ketahanan terhadap penyakit untuk kuantifikasi tingkat serangan penyakitnya. Tujuan dari studi ini yaitu untuk membuat 
metode analisis digital berbasis gambar untuk serangan penyakit layu Fusarium yang sederhana dan lebih objektif dengan menggunakan  
software ImageJ. Pisang Ambon dan Pisang Cavendish digunakan sebagai material tanaman karena sifatnya yang rentan terhadap serangan 
penyakit layu Fusarium. Analisis fusarium dilakukan mengikuti prosedur berikut (i) Pengambilan gambar pada rhizom yang terinfeksi 
Fusarium (ii) Analisis digital berbasis gambar menggunakan ImageJ pada gambar yang telah diambil. Hasil analisis digital ini berupa  
persentase area rhizom yang terinfeksi, ditunjukkan dengan adanya nekrosis dan diskolorasi. Persentase area yang terinfeksi Fusarium pada 
Pisang Ambon#1 yaitu 50,1%, sedangkan Pisang Ambon#2 yaitu 22,23%. Selain itu, persentase Pisang Cavendish#1 dan Pisang 
Cavendish#2 yaitu 28,52% dan 39,5%. Analisis digital berbasis gambar pada sampel yang diamati menunjukkan hasil yang konsisten dan 
lebih objektif. Pengembangan metode analisis gambar digital tidak hanya berguna untuk analisis serangan Fusarium di Pisang, akan tetapi 
dapat dilakukan pada tanaman lainnya.  
 
Kata kunci: Analisis Gambar  Digital, Im ageJ, Penyakit Layu Fusar ium, Pisang 

mailto:ahmadzaelani.zae@gmail.com
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Indeksasi tingkat serangan penyakit Fusarium 

berdasarkan perubahan warna (diskolorasi) pada 

bagian dalam bonggol (rhizom) yang saat ini banyak 

digunakan yaitu metode visual dengan menggunakan 

skala angka yang terbagi menjadi 5-6 kelas (Mak et 

al., 2004; Viljoen et al., 2016; García-Bastidas et al., 

2019). Klasifikasi 6 kelas tersebut yaitu 1 = Tidak 

ada tanda; 2 = Sedikit titik tanda; 3 = <1/3 jaringan 

tanaman terdiskolorasi; 4 = 1/3-2/3 = Jaringan  

tanaman yang terdiskolorasi; 5 = >2/3 Jaringan 

terdiskolorasi; 6 = Seluruh area rhizom  

terdiskolorasi. Namun, penggolongan 6 kelas  

tersebut masih dirasa kurang presisi dikarenakan 

tanaman terserang penyakit yang memiliki perbedaan 

diskolorasi sampai dengan 32% akan berada pada 

kelas yang sama. Oleh karena itu, keakurasian  

skoring untuk analisis serangan penyakit layu  

Fusarium sangat perlu untuk ditingkatkan. Seiring 

perkembangan kemajuan teknologi, indeksasi  

serangan Fusarium dalam bonggol sudah dilakukan 

dengan menggunakan metode visual secara digital 

(García-Bastidas et al., 2019; Orr et al., 2019).  

Garcia-Bastidas et al., (2019) menggunakan metode 

analisis digital dalam membantu kegiatan  

phenotyping pengujian tanaman pisang tahan layu 

Fusarium. Studi tersebut membuat indeks serangan 

penyakit layu Fusarium menjadi empat kelas, yaitu 1 

= 0 > x ≤ 25%, 2 = 25 < x ≤ 50%, 3 = 50 < x ≤ 75%, 

dan 4 = 75 < x ≤ 100%. Namun, protokol analisis 

digital yang dikembangkan tidak secara lengkap 

dilaporkan. 

Pada studi ini kami mengembangkan protokol 

kuantifikasi untuk analisis penyakit layu Fusarium di 

Pisang secara digital dengan menggunakan ImageJ. 

Protokol yang dikembangkan dalam studi ini  

diharapkan dapat mengurangi subjektifitas peneliti 

dalam analisis serangan penyakit Fusarium di pisang.  

 

BAHAN DAN CARA KERJA  

Material tanaman 

Pisang Ambon dan Pisang Cavendish digunakan 

sebagai material tanaman dalam kegiatan bioassay 

dengan jumlah ulangan masing-masing delapan  

individu dari tiap kultivar. Inokulum yang digunakan 

pada penelitian ini adalah Fusarium odoratissimum 

(Maryani et al., 2019). Perbanyakan inokulum  

dilakukan menggunakan media PDB (Potato  

Dextrose Broth) dengan inkubasi selama 5 hari.  

Inokulasi dilakukan 2 bulan setelah transplan di 

greenhouse khusus untuk pengujian penyakit layu 

Fusarium. Akar tanaman pisang dilukai 

menggunakan pisau yang ditusukkan ke media 

tanam, kemudian inokulum F. odoratissimum dengan 

kerapatan 1 x 106 dituangkan ke media tanam kecuali 

pada media tanam kontrol. Penyiraman tanaman  

dilakukan dengan menuangkan air ke dalam boks 

sampai setinggi kira-kira 2 cm. Hal ini dimaksudkan 

agar tanah dari satu polybag tidak berpindah ke  

polybag lain apabila terkena cipratan air saat 

penyiraman. Pengamatan dilakukan pada minggu  

ke-8 setelah inokulasi. Inokulasi dan pengamatan 

dilakukan di fasilitas greenhouse Pusat Penelitian 

Biologi, LIPI pada rentang waktu bulan Juli -  

September 2019.  

 

Pengambilan foto rhizom 

Setelah delapan minggu inokulasi, bonggol 

tanaman dibongkar dan dipotong secara membujur, 

kemudian dilakukan pengambilan foto. Pengambilan 

foto dilakukan dengan memperhatikan pencahayaan 

yaitu sumber cahaya tidak berada di belakang objek 

yang akan difoto (tidak backlight). Selain itu,bagian 

bonggol yang akan diambil fotonya harus bersih dari 

benda lain, seperti tanah, sampah daun dan  

sebagainya. 

 

Analisis image digital dengan ImageJ 

Tingkat diskolorasi pada bonggol pisang yang 

sudah diinokulasi patogen Fusarium dianalisis 

dengan menggunakan perangkat lunak ImageJ. 

Langkah-langkah analisis image digital dengan 

menggunakan ImageJ adalah sebagai berikut: 

1. Buka software ImageJ. 

2. Buka foto. File > Open. Pastikan foto telah 

dipotong sehingga hanya ada bagian jaringan  

pembuluh (central vascular region) saja.  

3. Buat duplikasi foto. Image > Duplicate. Tetap 

buka kedua foto untuk memudahkan analisis.  

Foto yang sedang dianalisis dan foto awal dapat 

dibandingkan. Langkah ini dapat membantu  

perbandingan untuk penentuan area yang terinfeksi 

Fusarium.  

4. Menentukan ambang batas (Threshold). Image > 

Adjust > Color Threshold.  
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Atur brightness untuk memilih area yang akan  

dianalisis.  

5. Menentukan luas area yang diukur. Setelah 

mengatur brightness pada menu color threshold, 

kemudian kita tekan opsi select untuk menentukan 

luas area yang akan diamati.  

6. Pengaturan Set Measurement. Analyze > Set Meas-

urement >  tandai opsi “Area”, “Display label”. Atur 

Redirect to: (nama file) 

7. Pengaturan nilai: Analyze > Measurement (Ctrl + 

M).  

8. Akan muncul hasil berupa Label (nama file), dan 

area (satuan pixel) 

9. Simpan hasil. File > Save as. File akan tersimpan 

dalam format CSV. 

Disamping itu kami juga melakukan kuantifikasi 

serangan penyakit layu Fusarium dengan 

menggunakan metode Orr et al. (2019) sebagai  

pembanding.  

 

Analisis data 

Data yang diperoleh yaitu luas area yang  

terinfeksi dan luas seluruh area jaringan pembuluh di 

rhizom yang diamati dalam satuan pixel. Hasil yang 

didapat dari analisis tersebut, kemudian dihitung 

dengan menggunakan formula sebagai berikut:  

HASIL 

Langkah-langkah analisis digital dengan 

menggunakan ImageJ dapat dilihat di Gambar 1. 

Setelah dipotong menjadi dua bagian secara  

membujur, bonggol yang terinfeksi kemudian difoto 

untuk selanjutnya dianalisis dengan menggunakan 

ImageJ. Tiga langkah pengukuran tingkat  

diskolorasi yang sangat perlu diperhatikan dalam 

analisis, yaitu penentuan ambang batas (threshold), 

pengaturan tingkat kecerahan (brightness), dan  

pilihan set measurement. Luaran analisis 

menggunakan pendekatan dalam studi ini yaitu  

persentase area terinfeksi yang ditunjukkan dengan 

adanya diskolorasi pada area rhizom (Gambar 2.).  

Output dari analisis digital ImageJ berupa angka 

dalam satuan pixel yang kemudian dijadikan nilai 

rasio atau persentase. Rasio area yang terinfeksi 

kemudian dibagi dengan seluruh area yang diamati, 

sehingga dihasilkan nilai persentase area yang  

terinfeksi Fusarium. Nilai persentase area yang  

terinfeksi dari hasil analisis digital yang kami  

kembangkan menunjukkan nilai 50,1% dan 22,23% 

area pada Pisang Ambon yang terinfeksi Fusarium. 

Sementara itu, area Pisang Cavendish yang terserang 

Fusarium yaitu 28,52% dan 39,5% (Tabel 1.) 

Untuk mengkonfirmasi metode yang  

dikembangkan dalam studi ini, kami melakukan  

analisis digital ImageJ dengan menggunakan metode 

Tabel 1. Hasil analisis berupa persentase area yang terinfeksi Fusarium dari metode yang  
dikembangkan dan metode Orr et al. (2019) (Analysis result in the form of Fusarium infected 
area resulted from developed method and method developed by Orr et al. (2019)) 

No 
Sampel 

(Sample) 

Metode yang  
dikembangkan 

(Developed method) 

  
Persentase 

area yang 
terinfeksi 

(%) 
(Percentage 
of infected 

area) 

Metode Orr et al, (2019) (Method 
developed by Orr et al., (2019)) 

  
Persentase 

area yang 
terinfeksi 

(%) 
(Percentage 
of infected 

area) 

Area  
terinfeksi 

(pixel) 
(Infected 

area) 

Seluruh 
area 

(pixel) (all 
area) 

Mean gray  
value area  
terinfeksi 

(Mean gray 
value of infected 

area) 

Mean gray  
value seluruh 

area gelap 

(Mean gray 
value of dark 

area) 

1 Ambon#1 43742 87303 50.1 163.347 255 64.06 

2 Ambon#2 28685.5 129017 22.23 175.1295 255 68.68 

3 Cavendish#1 13663 47915 28.52 190.551 255 74.73 

4 Cavendish#2 30719 77776.5 39.5 193.3805 255 75.84 
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Gambar 2. Penampakan hasil analisis image digital dengan menggunakan ImageJ . 1a-1d dianalisis 
dengan menggunakan metode yang dikembangkan; 1e-1h dianalisis menggunakan metode Orr 
et al. (2019). Pisang Ambon (a, b, e, f); Pisang Cavendish (c, d, g, h). (Appearance of digital 
image analysis result using ImageJ. 1a-1d analysed using developed method, 1e-1h analysed 
using method Orr et al. (2019). Pisang Ambon (a,b,e,f), Pisang Cavendish (c, d, g, h)) 
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kuantifikasi yang telah dikembangkan sebelumnya 

(Orr et al., 2019). Persentase area yang terinfeksi 

dengan menggunakan metode Orr et al. (2019) pada 

Pisang Ambon#1 yaitu 64,06% dan Pisang Ambon#2 

sebesar 68,68%. Sementara itu, persentase dari 

Pisang Cavendish#1 dan Pisang Cavendish#2 sebesar 

74,73% dan 75,84% (Tabel 1). 

 

PEMBAHASAN 

Pada studi ini, kami menggunakan pendekatan 

analisis digital berbasiskan foto dengan ImageJ  

untuk menganalisis serangan penyakit layu Fusarium 

di pisang. ImageJ merupakan program open source 

berbasis bahasa pemrograman Java yang tersedia di 

website (http://rsbweb.nih.gov/ij/). Program ini dapat 

digunakan untuk membantu analisis digital  

berbasiskan foto yang telah diambil.  

Perbedaan persentase area terlihat antara 

metode yang kami kembangkan dengan metode Orr 

et al. (2019). Dalam studi ini, kami menggunakan 

opsi “area” untuk menganalisis bonggol pisang yang 

terinfeksi, sedangkan Orr et al. (2019) menggunakan 

gambar biner di dalam ImageJ dengan kisaran nilai  

0 –255.  

Interpretasi dari gambar biner mempunyai 

kelemahan yaitu tidak dapat dilakukan secara  

universal di ImageJ, hal tersebut dikarenakan  

foreground dan background pada foto yang diambil 

berpengaruh pada luaran atau hasil analisis. Selain 

itu, rasio pembagi yang mengikuti nilai tertinggi dari 

gambar biner yaitu 255 kurang fleksibel  

dibandingkan dengan menggunakan opsi “area” yang 

nilainya dapat berubah sesuai dengan ukuran gambar 

yang digunakan.  

Pengembangan aplikasi analisis digital pada 

tumbuhan sudah masif dikembangkan. Beberapa 

aplikasi analisis digital pada tumbuhan, diantaranya 

(Dhingra et al., 2018; Khirade dan Patil, 2015; 

Meena Prakash et al., 2018). Khirade dan Patil, 

(2015) menggunakan metode ANN untuk klasifikasi 

penyakit pada tanaman. Dari metode ini, tanaman 

dapat diidentifikasi dan diklasifikasikan dari 

berbagai penyakit tanaman secara akurat dengan 

menggunakan teknik pemrosesan gambar. Secara 

khusus, pengembangan metode analisis untuk 

penyakit Fusarium pada tanaman sudah 

dikembangkan, salah satu contohnya yaitu pada 

tanaman gandum (Jayme G.A. Barbedo et al., 2015; 

Jayme Garcia Arnal Barbedo et al., 2016; Maloney et 

al., 2014; Shin et al., 2014). 

 

KESIMPULAN 

Metode analisis digital yang dikembangkan 

pada studi ini sederhana dan mudah dilakukan. Hasil  

analisis serangan Fusarium lebih konsisten dan  

objektif dibandingkan dengan metode visual  

konvensional. Selain itu, metode kuantifikasi  

penyakit layu Fusarium ini juga memiliki potensi 

untuk bisa diaplikasikan pada tanaman selain pisang. 

Oleh karena itu, kami harapkan studi ini dapat  

menjadi standar atau protokol yang dapat digunakan 

dalam analisis serangan penyakit layu Fusarium di 

pisang. Sehingga pengembangan varietas pisang 

unggul baru yang tahan terhadap penyakit layu 

Fusarium dapat dilakukan lebih efektif dan efisien.  
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